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Step 7: Designing (in context) the Blade Step 8: Creating Checks and Reactions Step 9: Creating the Template Step 10: Protecting the IP
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Knowledge-Based Engineering



Stringer



Student Notes:



Master Exercise Presentation 65 min



In this exercise, you will design the Stringer part and control its modification using the Knowledgeware tools.



In this exercise, you will practice:
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Creating User Parameters Creating Formulas Creating geometry using User Parameters Creating Rules and Checks for the design Creating a Design Table and changing configurations using the design table
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Knowledge-Based Engineering Student Notes:



Design Intent – Stringer



A check observes this ‘Bracket Hole Pattern’ and displays an error message if the holes in the pattern fall outside the Stringer length.
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The size of the holes and its spacing is governed by a rule, which decides the size and spacing depending upon the available size of the bracket fitting into these holes.
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The pockets’ design can be changed from oval to circular by changing a configuration in the design table.
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Stringer - Design Process (1/2) 1



Creating User Parameters 2



3
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4



Creating formulas between the User Parameters and the dimensions



Creating geometry using the User Parameters



Creating a Rule to control the spacing and the hole diameter as per the pre-defined designs of the brackets, which will be fixed in these holes
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Stringer - Design Process (2/2) 5



Creating a Check to observe the pattern of the holes
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Creating a new Design Table from the existing User Parameters



7



Changing the configuration and updating the design
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Master Exercise Part 1 Design Process – Part 1 35 min



1



Creating User Parameters 2



Creating formulas between the User Parameters and the dimensions
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Creating geometry using the User Parameters
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Knowledge-Based Engineering



Stringer



Student Notes:



Step 1 – Creating User Parameters 10 min
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In this step, you will create parameters and assign values to them.
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Knowledge-Based Engineering Student Notes:



Step 1: Creating User Parameters Part used: Stringer_start.CATPart Open the part and note the parameters that are already created for you. Create additional parameters and assign values to them as specified in the chart below.



Type = Length



Type = Integer
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Type = Boolean



Copyright DASSAULT SYSTEMES



User Parameter Name Bracket_Hole_Instanc es Bracket_Spacing_De sign



Type



Value (s)



Integer



Design50,8Design60, Design70



String



Parameter with multiple values
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Stringer



Student Notes:



Step 2 – Creating Formulas Using User Parameters 15 min
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In this step, you will create formulas using the User Parameters.
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Knowledge-Based Engineering



Step 2: Creating Formulas Using User Parameters (1/5)



Student Notes:



Open the ‘Sketch.Iprofile’ and note the six formulas that are already created for you. 1 2



7 8



3



6
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5 4



To be able to view the names of the parameters with values and formulae, select Display Mode = ‘Name + Value + Formula’ in Tools > Options > Parameters and Measures > Constraints and Dimensions (tab) > Constraint Display.



Create the formulas 7 and 8 as shown in the image of ‘Relations’ node above.
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Step 2: Creating Formulas Using User Parameters (2/5)



Student Notes:



Create ‘Formula.9’ and ‘Formula.10’ for parameters ‘Length’ and ‘CornerRadius’ respectively as shown below.
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Edit both the sketches of Pocket.OvalHole and Pocket.CircularHole and create the formulas as illustrated below:
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Step 2: Creating Formulas Using User Parameters (3/5)



Student Notes:
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Connect the Activity parameters of the pocket features and their pattern features to both the Boolean user parameters as shown below.
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Knowledge-Based Engineering



Step 2: Creating Formulas Using User Parameters (4/5)



Student Notes:



Parameterize the pattern of ‘Pocket.OvalHole’. Set the activity of the ‘OvalHole’ parameter to ‘true’.
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Edit the ‘RectPattern.OvalHole’ rectangular pattern. Create a formula to link the number of instances to the dedicated user parameter. Create the formula as shown in the image below to define the spacing between the holes. Do not forget to use brackets to delimit the fields.
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Step 2: Creating Formulas Using User Parameters (5/5)



Student Notes:



Repeat the same process for pattern of ‘Pocket.OvalHole’. Set the activity of the ‘OvalHole’ parameter to ‘false’ and the activity of ‘CircularHole’ to ‘true’.
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The formula for the spacing in this case will be as shown below.
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Knowledge-Based Engineering Student Notes:



Stringer Step 3 – Creating Geometry using User Parameters 10 min



In this step, you will create geometry using User Parameters.
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Step 3: Creating Geometry using User Parameters (1/2) Create holes that will be used to fix a single or multiple brackets in the Stringer. Create a plane offset to the zx plane at a distance equal to the height parameter.



=



Select this plane as support and create a hole as shown.



Open the sketch of the hole and position it with respect to the edges using parameters and formulae, as shown in the figure. = TopWidth – (Thickness/2) - BracketHole1X
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= BracketHole1Z



Associate the diameter of this hole to the parameter ‘BracketHoleDiameter’.
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Step 3: Creating Geometry using User Parameters (2/2)



Student Notes:



Create a pattern of this hole using parameters and values as shown. Instance (s) = Spacing =
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These holes will be used to fix one or more brackets
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Knowledge-Based Engineering



Master Exercise Part 2 Design Process – Part 2 15 min



4



Student Notes:



Creating a Rule to control the spacing and hole diameter as per the pre-defined designs of the brackets, which have to be fixed in these holes
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Creating a Check to observe the pattern of the holes
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Knowledge-Based Engineering Student Notes:



Stringer Step 4 – Creating Rules 10 min



In this step, you will create rule(s) to control the design modifications of the Stringer part.



Bracket Design = Design70
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Bracket Design = Design50
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Step 4: Creating Rules (1/2) CATIA data used: Stringer_Part2_Start.CATPart Create a ‘Rule’ which will incorporate the following cases for the parameter ‘Bracket_Spacing_Design’.
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If ‘Bracket_Spacing_Design’ =



Then



Design50



BracketHolesSpacing = 50mm BracketHoleDiameter = 7.0mm



Design60



BracketHolesSpacing = 60mm BracketHoleDiameter = 7.5mm



Design70



BracketHolesSpacing = 70mm BracketHoleDiameter = 8.0mm
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Step 4: Creating Rules (2/2)



Student Notes:
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You can use the following code in the ‘Rule Editor’.
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Stringer



Student Notes:



Step 5 – Creating a Check 5 min



Copyright DASSAULT SYSTEMES



In this step, you will create a ‘Check’ to observe the pattern of the holes.
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Step 5: Creating Check



Student Notes:



Create a check to verify that the holes created by the pattern do not cross the Stringer length, resulting into invalid form of pattern.



You can use the settings and the line of code in the ‘Check Editor’ as shown above.
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You can also verify the warning of the ‘Check’ by assigning the values to the parameters as shown below.
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Master Exercise Part 3 Design Process – Part 3 6 15 min



Creating a new Design Table from the existing User Parameters
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Changing configuration and updating the design
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Stringer



Student Notes:



Step 6 – Creating a ‘Design Table’ 10 min



Copyright DASSAULT SYSTEMES



In this step, you will create a new Design Table from some of the existing user parameters.
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Step 6: Creating a ‘Design Table’



Student Notes:



Part used: Stringer_Part3_Start.CATPart



Create a ‘Design Table’ named “DesignTable.Stringer” of all the ‘User Parameters’ except the following: 1. 2. 3. 4.



BracketHoleDiameter BracketHolesSpacing Bracket_Hole_Instances Bracket_Spacing_Design



Click ‘OK’ and save the ‘Design Table’ as .xls or .txt file.
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Reopen the ‘Design Table’ and click the ‘Edit Table’ button to create the design configurations as shown in the adjoining table.
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Stringer



Student Notes:



Step 7 – Changing design Configuration and Updating 5 min
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In this step, you will switch between the different design configurations that you have created in the design table.
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Step 7 – Changing design Configuration and updating



Student Notes:
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Open the design table and switch between the configurations in the design table. Update if necessary.



This step completes the Stringer exercise.
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Knowledge Advisor Added Exercises



Student Notes:
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Light Bulb Exercise Sheet Metal Part Exercise Wheel Rim Exercise
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Light Bulb



Student Notes:



Added Exercise Presentation 1 hour



In this exercise you will: Embed the knowledge within the design of a light bulb assembly using Formulas, Rules and Checks. Define a light bulb family using a Design Table. Determine the impacts and dependencies of a parameter modification using the Knowledge Inspector tool.
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Automate drawing creations using the VBscript Macros launched from rules.
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Design Intent: Light Bulb
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In the context of an assembly representing a light bulb:
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Create User Parameters and formulas Create a rule to keep a specific ratio value in the bulb design Create checks to inform the user that the ratio limit values have been reached Analyze the impacts of a parameter value modification using the Knowledge Inspector Create a design table to ease the definition and the use of alternate designs for the assembly Automate the creation of drawings using macros Create and use catalogs of standard components
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Design Process: Light Bulb Step 1 : Create user parameters and formulas



Step 2 : Create a Rule



Step 3 : Use the Knowledge Inspector tool



Step 4: Create a Design Table



Step 7: Create a bulb glass family catalog
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Step 5/6 : Generate a drawing with a Macro launched from a Rule or a Reaction
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Light Bulb



Student Notes:



Step 1 - Create User Parameters and Formulas 10 min



In this step you will create four User Parameters: Bulb_Height Bulb_Diameter Bulb_Ratio (stands for the ratio of the bulb’s height to its diameter (ratio=Height/Diameter) )
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Wet_Area
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Do It Yourself (1/2)



Student Notes:



Catalog.CATMaterial



In CATIA V5 Tools/Options, declare as default catalog the Material catalog furnished with the training data: …/Student/Data/Light_Bulb_Assembly/Catalog.CATMaterial. This will add a new glass material in your material library.



2.



Choose the correct display mode to see the materials.
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1.



Copyright DASSAULT SYSTEMES



37



Knowledge-Based Engineering



Do It Yourself (2/2)



Student Notes:



Open CATKWA_LightBulb_Assy_Start.CATProduct At the root level, create two User Parameters of type Length: Bulb_Height =34mm Bulb_Diameter =24mm



2.



Create a Parameter « Bulb_Ratio » of type Real defined by the formula: Bulb_Ratio=Bulb_Height /Bulb_Diameter



3.



Add the following formula on Glass_Bulb\Glass_Height parameter : Glass_Bulb \Glass_Height =Bulb_Height



4.



Activate the Glass_Bulb Component and create a parameter of type Area. Rename it « Wet_Area » and define it with the formula : Wet_Area=smartWetarea (PartBody\Shaft)
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1.
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Light Bulb



Student Notes:



Step 2 - Create a Ratio Rule 10 min
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In this step, you will create a Rule that will ensure that the bulb ratio (Height/Diameter) always remains between 1.125 and 1.7 in order to avoid to get strange bulb shapes.
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Do It Yourself 1.



Student Notes:



At the root level, create a Rule named « Bulbshape » with the following instructions :



if ( Bulb_Height / Bulb_Diameter ) > 1.7 {Glass_Bulb\Radius_Bulb = Bulb_Height / (2*1.7) Bulb_Ratio = 1.7 Message ("The Ratio has reached its upper limit of 1.7. | Bulb diameter has been modified accordingly.| Bulb diameter is driven by ratio of 1.7 of the Bulb_Height")} else if (Bulb_Height / Bulb_Diameter) < 1.125 {Glass_Bulb\Radius_Bulb = Bulb_Height / (2*1.125) Bulb_Ratio = 1.125 Message("The Ratio has reached its lower limit of 1.125.| Bulb diameter has been modified accordingly.| Bulb diameter is driven by ratio of 1.125 of the Bulb_Height.")} Else
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{Glass_Bulb\Radius_Bulb = Bulb_Diameter / 2 Bulb_Ratio = Glass_Bulb\Glass_Height / (2 * Glass_Bulb\Radius_Bulb)} Filament_Support\WireSupport_Height = Glass_Bulb\Glass_Height - Glass_Bulb\Radius_Bulb



2.



Click “Yes” in the « Conflicts Warning » panel in order to avoid a valuation conflict between Formula.5 and this new Rule.
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Light Bulb



Student Notes:



Step 3 - Use the Knowledge Inspector Tool 10 min
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In this step, you will use the Knowledge Inspector tool to understand what are the impacts in the light bulb design of the Bulb_Height parameter modification.
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Knowledge-Based Engineering



Do It Yourself In the Knowledge Inspector panel, select the « What if » mode.



2.



Change the value of Bulb_Height from 34mm to 50mm and click the Apply button. Analyze the impacts of this modification.



3.



Change the value of Bulb_Height from 50mm to 26mm and click the Apply button. Analyze the impacts.



4.



Click the Cancel button so that the parameter modification is not taken into account.
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1.



Student Notes:
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Light Bulb



Student Notes:



Step 4 - Create a Design Table 10 min
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In this step, you will create a Design Table to manage a light bulb family. Two different creation methods will be used.



Copyright DASSAULT SYSTEMES



43



Knowledge-Based Engineering



Do It Yourself 1.



Student Notes:



Creation method N°1 : Create a Design Table named « Bulb_Family » and check the option « Create a design table with the current parameter values ». Add four new configurations as shown below.



Change the configuration to N°5
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2.



Creation method N°2 : Delete the previous Design Table. Create a new Excel file using the data shown in the above image: « CATKWA_Bulb_Family.xls ». Use the Automatic association and associate manually the « Glass_Bulb\Material » parameter to the « Material » column.
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Light Bulb



Student Notes:



Step 5 - Lauching a Drawing Macro from a Rule 5 min
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In this step, you will create a Rule that will launch macros to create the bulb drawing automatically. If your bulb is an American type, a macro will create projection views using the third angle standard and if it is an European bulb, another macro will create projection views using the first angle standard.
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Do It Yourself 1.



Create a Parameter of type String with two multiple values (In_Progress and Completed) and rename it « WorkStatus ». Set it to « In_Progress ».



2.



Create a Rule named « Drawing Creation » with the following script :



Student Notes:



if WorkStatus == "Completed" { if Socket_Type == "American" { LaunchMacroFromDoc ("American_Drawing_Creation") } else if Socket_Type == "European" {LaunchMacroFromDoc("European_Drawing_Creation")}}
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3.



Change the WorkStatus parameter from « In_Progress » to « Completed ». It will automatically create the appropriate drawing views.



Note: You can view both the used macros using the Tools/Macro command.
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Light Bulb



Student Notes:



Step 6 - Launching a Drawing Macro from a Reaction 5 min
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In this step, you will create a Reaction that will launch macros to automatically create the bulb drawing.
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Knowledge-Based Engineering



Do It Yourself Deactivate the Rule that you have created in the last step.



2.



Create a Reaction (Knowledgeware action type) which triggers the same drawing process then the « WorkStatus » parameter value is equal « Completed ». At the end of the instructions, add the line WorkStatus =« In_Progress » so that the parameter gets back its original value. Notice that is not possible in a Rule to do so.



3.



Change the « WorkStatus » parameter from « In_Progress » to « Completed ». It will automatically create the appropriate drawing.
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1.



Student Notes:
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Light Bulb



Student Notes:



Step 7 : Create a Bulb Glass Family Catalog 10 min



In this step you will: Create a bulb glass family catalog



Copyright DASSAULT SYSTEMES



Reuse it in an assembly
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Do It Yourself: Glass Catalog Creation



Student Notes:



Open CATKWA_GlassBulb_DT.CATPart Edit DesignTable.1 and insert a column « PartNumber » in the Excel sheet. Specify a PartNumber value for each row, « height*radius_material » for example.



2.



Save the CATPart and close it.



3.



Create a new CatalogDocument.



4.



Rename the default chapter in « Bulbs » and add a part family named « Glasses » using the CATKWA_Glass_Bulb_DT.CATPart document.



5.



Resolve the new part family.



6.



Save and close the Catalog document.
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1.
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Do It Yourself: Glass Catalog Reuse



Student Notes:



Open CATKWA_LightBulb_Assy_NoGlass.CATProduct



In this product, instantiate the « 34*12_ClearGlass » component from your catalog browser. Change its PartNumber into « Glass_Bulb ».



2.



Create one coincidence constraint between the Glass_Bulb axis and the Socket axis.



3.



Create one contact constraint between the two planes as shown on the right picture.



4.



Add the following formula: Glass_Bulb\Glass_Height =Bulb_Height
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1.
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Sheetmetal Part



Student Notes:



Sheetmetal Part Exercise: Presentation 25 min



In this exercise you will: Use a List to automatically get the total number of bends Use a Rule to compute the part’s cost
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Use a Check to control the over cost
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Design Intent: Sheetmetal Part



Student Notes:



In the context of a part representing a Sheetmetal Part… Creating User Parameters Creating a List Copyright DASSAULT SYSTEMES



Creating a Formula Creating a Rule Creating a Check
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Design Process: Sheetmetal Design Step 1 : Create User Parameters and Formulas



Step 3 : Create a cost Rule



Step 2 : Create a bend List
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Step 5: Create new Bends and evaluate the cost



Step 4: Create a cost Check
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Sheetmetal Part



Student Notes:



Step 1 - Create User Parameters 5 min



In this step, you will create two User Parameters: “UnitBendCost” for the cost of one bend
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“TotalBendCost” for the bend’s total cost
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Do It Yourself



Student Notes:



Open SheetMetalPart.CATPart Create two Parameters :
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UnitBendCost = 10 as Real. TotalBendCost = 0 as Real.
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Sheetmetal Part



Student Notes:



Step 2 - Create a Bend List 5 min
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In this step, you will create a List that will be automatically populated with the sheetmetal part bends.
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Knowledge-Based Engineering



Do It Yourself 1.



Create a new empty List named « BendList »



2.



Add the following formula on the BendList parameter to automatically populate the List with the existing bends:



Student Notes:



BendList = PartBody .Query("Bend","")
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Note that there is a space between “PartBody” and “.Query” …
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Sheet Metal Part



Student Notes:



Step 3 - Create a Cost Rule 5 min



In this exercise, you will create a Rule that will compute the total cost of the bends. This cost depends on: The number of bends The bend unit cost The sheetmetal part’s thickness
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The sheetmetal part’s material
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Do It Yourself 1.



Student Notes:



Create a Rule named « CostUpdate » with the following instructions : If Material == "Aluminium" {TotalBendCost = BendList\Size * UnitBendCost * `Sheetmetal Parameter.1\Thickness`/1mm * 1.000} else
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{TotalBendCost = BendList\Size * UnitBendCost * `Sheetmetal Parameter.1\Thickness`/1mm * 1.500}
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Sheet Metal Part



Student Notes:



Step 4 - Create a Cost Check 5 min
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In this step, you will create a Check to warn the user in case the maximum cost value is exceeded.
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Knowledge-Based Engineering



Do It Yourself 1.



Student Notes:



Create a Check named « CostCheck » and defined by the condition : TotalBendCost Options. Check the “Instantiate only resolved family components” option and choose the folder in which the resolved CATParts will be created.
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4.



Student Notes:
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Do It Yourself (3/3) Open the contextual menu of the family to resolve it. A CATPart corresponding to each configuration of the initial design table is created in the directory you have indicated in the settings.
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7.



Student Notes:
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Wheel Rim Step 8 - Create a Reaction to Control the Wheel Rim Diameter 10 min



In this step you will: Create a Reaction to ensure that the current wheel radius is always one of the standard value contained in the “Wheel_Sizing” Design Table. Thanks to this reaction, this standard value will be the closest value from the one specified by the user while modifying the “Rim_Size” parameter value (see diagram below). Create a Rule to activate/de-activate some Relations depending on the wheel dimensions modification mode: By changing the Design Table active configuration (“Design Table mode”) By changing individually the rim parameter values (“Manual Mode”)
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Manual Mode: « Rim_Size » Value modification
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Yes



Apply this value to the wheel geometry



No



Apply the closest standard value contained in the « Wheel_Sizing » Design Table



Standard Value ?
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Do It Yourself (1/3) 1.



Create a new string User Parameter named Rim_Size_Driving_Mode with two values: “Design_Table_Mode” and “Manual_Mode”



2.



In “Rules_and_Reactions” create a Reaction named “Closest_Std_Rim_Size”. This Reaction will react to the “Rim_Size” parameter value changes and will ensure that this parameter has a standard value contained in the “Wheel_Sizing” design table.



Student Notes:



Copyright DASSAULT SYSTEMES



To be able to select the Rim_Size as the source parameter, you will have to deactivate the design table before defining the reaction.



3.



Select the Rim_Size parameter as the source and copy the script contained in “CATKWA_Wheel_Rim_Reaction.doc” in the Action editor. You will find this document in the same directory than the initial Wheel Rim CATPart.
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Do It Yourself (2/3) 4.



In “Rules_and_Reactions” create a Rule named “Driving_Mode”. This rule will deactivate either the Reaction or the “Wheel_Sizing” design table depending on the Rim_Size_Driving_Mode parameter value:



“Closest_Std_Rim_Si ze” Reaction Activity



“Wheel_Sizing” Design Table Activity



True



False



False



True
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Closest_Std_Rim_Siz e Value “Manual_Mode” “Design_Table_Mode "
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Do It Yourself (3/3)



Student Notes:



Open CATKWA_Wheel_Rim_End.CATPart to check your result. 5.



Test the “Manual_Mode” driving mode: • • •



6.



Valuate the Rim_Size_Driving_Mode parameter to “Manual_Mode” Modify the Rim_Size parameter value to 13in, 12.9in, 17.2in and 18.5in Notice that when the specified value for the Rim_Size parameter is not a standard one, the Reaction forces the parameter value to the closest standard value



Test the “Design_Table_Mode” driving mode: Valuate the Rim_Size_Driving_Mode parameter to “Design_Table_Mode” Change the “Wheel_Sizing” Design Table active configuration
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• •
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Knowledge-Based Engineering



Key-Way



Student Notes:



PowerCopy Recap Exercise 30 min



The objective of this exercise is to create a PowerCopy of a key-way which will always be compliant with a specific standard.
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Prerequisites: Knowledge Advisor
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Knowledge-Based Engineering Student Notes:



Step 1: Design the Key-Way (1/5) Open CATPKT_KeyWay_Solution_Step1_Start.CATPart. Open the CATPart and study the features already created for you.



Center2



Orientation Plane (XY)



Positional Sketch



Limit_Edge



Center1 Shaft_Axis
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Reference_Edge
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Step 1: Design the Key-Way (2/5) Create 5 Length Parameters: Edge_Distance = 20mm Slot_Length = 40mm Shaft_Diameter= length(`Geometrical Set.1\Reference_Edge`)/PI Slot_Width = 18mm j = 53mm



Edge_Distance



Slot_Length



Slot_Width
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Create formulas to link the three sketch dimensions to the following user parameters: Edge Distance Slot Length Slot width
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Knowledge-Based Engineering



Step 1: Design the Key-Way (3/5)



Student Notes:



Create a Pocket from positioned sketch: First limit: Up to next Second limit depth = (-1)*(j -(Shaft_Diameter /2))



Create a Knowledge Advisor Rule named “Standard_Rule”: In the body of the rule copy and paste the script, contained in “CATPKT_Standard_Rule.txt” file, Companion users will find it in detailed steps. This rule drives the key-way width and depth in relation to the shaft diameter. Create a Knowledge Advisor Check called “Shaft_Diameter” of type Warning: Condition:



Shaft_Diameter >= 8mm and Shaft_Diameter the message now indicates that the distance is correct.
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Center Hole



Student Notes:



User Defined Features Recap Exercise 20 min



The objective of this exercise is to create a DIN standard center hole feature.



Copyright DASSAULT SYSTEMES



Prerequisites: Knowledge Advisor
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Knowledge-Based Engineering



Center Hole



Student Notes:



Step 1: Design the Center Hole 10 min
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In this step, you will insert intelligence in a hole using a Knowledge Advisor rule.



Copyright DASSAULT SYSTEMES



116



Knowledge-Based Engineering



Design the Center Hole (1/4)



Student Notes:



Open CenterHole_Start.CATPart
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Open the CATPart and study the geometry already created for you. First Groove DIN_332_T1_R Second Groove DIN_332_T1_A
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Knowledge-Based Engineering



Design the Center Hole (2/4)



Student Notes:



Create four formulas for the dimensions of Sketch.2 of the first groove DIN_332_T1_R as shown in the image.



=d1 =d1/2 =d2/2
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=t1
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Knowledge-Based Engineering Student Notes:



Design the Center Hole (3/4) Create three formulas for the dimensions of Sketch.3 of the second groove DIN_332_T1_A as shown in the image.



=t1



=d2/2
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=d1/2



Create a Dimensions Rule Use « Dimensions_Rule.txt » file to create a new Knowledge Advisor Rule that will drive « d2 » and « t1 » parameter values according to « d1 » value.
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Knowledge-Based Engineering



Design the Center Hole (4/4)



Student Notes:



Create a Rule to activate/deactivate the Groove features according to the « Type » parameter value: if Type == "R" {PartBody\DIN_332_T1_R\Activity = true PartBody\DIN_332_T1_A\Activity =false}
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if Type == "A" {PartBody\DIN_332_T1_R\Activity = false PartBody\DIN_332_T1_A\Activity =true}
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Knowledge-Based Engineering



Center Hole



Student Notes:



Step 2: Create and Store the Center Hole UserFeature 5 min
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In this step, you will define the contents of the user Defined Feature and store it into a catalog.
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Knowledge-Based Engineering



Create and Store the Center Hole User Feature



Student Notes:
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Create a UserFeature named « DIN_332_T1_CenterHole » including: Axis System.1 Parameters node Relations node The 2 grooves and sketches Plane.1 Point.1 Line.2 Publish « d1 » and « Type » parameters Choose a dedicated icon
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Knowledge-Based Engineering



Center Hole



Student Notes:



Step 3: Instantiate the Center Hole 5 min
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In this step, you will instantiate the User Defined Feature in a new context.
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Knowledge-Based Engineering



Instantiate the Center Hole



Student Notes:



Open CATPKT_CenterHole_destination.CATPart



Instantiate the previous User Feature and select the Shaft.1 circular edge as the input.
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Play with d1 and Type parameters to modify the center hole shape and the center hole dimensions.
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Document Templates Recap Exercises



Student Notes:



You will practice Document Templates through three exercises:
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Rod Part Template Recap Exercise Support Part Template Recap Exercise Tow Hook Assembly Template Recap Exercise
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Knowledge-Based Engineering



Rod Exercise



Student Notes:



Part Templates Recap Exercise 10 min
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In this exercise, you will create a Part Template based on a connecting rod design. Store it in a catalog and reuse it in an assembly.
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Knowledge-Based Engineering



Rod



Student Notes:



Step 1: Create and Store the Part Template 5 min
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In this step of the exercise, you will create the Part Template and store it in a catalog.
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Knowledge-Based Engineering



Create and Store the Part Template



Student Notes:



Open: Part_Template.CATProduct Check that you are working with the option “Keep link with selected object” on (Part Infrastructure options). Ensure that you do not allow hybrid body creation. Open the Part_Template.CATProduct and study the features already created for you.



Axis
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Rod
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Knowledge-Based Engineering



Create and Store the Part Template



Student Notes:



Create the Part Template: Activate the “Rod” part and use Insert / Document Template Creation command You should get one document in the Documents tab In the Inputs tab you should get two geometric inputs: Rod\External References\Curve.1 Rod\External References\Curve.2 Rename them as “CircularEdge1” and “CircularEdge2” Publish the Sketch.1 offset parameter and rename it as “Length” Choose a dedicated icon and make a grab screen Store the template in a catalog:
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Create a new CatalogDocument and store the Document Template
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Knowledge-Based Engineering



Rod



Student Notes:



Step 2: Instantiate the Part Template 5 min
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In this step of the exercise, you will instantiate the Part Template in an assembly context.
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Knowledge-Based Engineering



Instantiate the part template



Student Notes:



Open: CATPKT_Rod_Destination.CATProduct Instantiate the Part Template:
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Click the Catalog Brower icon and retrieve the template stored in the last step Select the two circular edges of Pad.1 in the “Axis” part Repeat the same operation using the edges of Pad.2, and click the Parameters button to modify the Rod’s length.
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Support



Student Notes:



Part Templates Recap Exercise Presentation 30 min
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In this exercise you will create a Part Template, store it in a catalog, and reuse it in an assembly.
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Knowledge-Based Engineering Student Notes:



Support: Design Process 1



Create and store the Part Template
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2



Understand the design intent
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3



Instantiate the Part Template and modify the assembly
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Support



Student Notes:



Step 1: Understanding the Design Intent 20 min
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In this step, you will understand the design intent of the template and create a rule.
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Knowledge-Based Engineering



Do It Yourself (1/3)



Student Notes:



Part used: Support_Part_Template_Step1_START.CATProduct The Support part is created in context of the CATPKT_0210 part.



The support part contains: A Plate (which inherits the geometry of CATPKT_0210 as shown above) A tube Stiffeners (which are duplicated using circular pattern
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Various parameters to control the design of Support part are also created.



Copyright DASSAULT SYSTEMES



135
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Do It Yourself (2/3)



Student Notes:



The design intent here is to create a template of this Support part so that it can be instantiated and correctly adapted to a new context.
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It is also desired that if the length of the tube of the Support part is greater than 150mm, the number of stiffeners is to be increased to 4.
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Knowledge-Based Engineering Student Notes:



Do It Yourself (3/3) The first part is taken care by designing the Support part in context.



Note the while designing in context, published elements are used. This helps in adapting the support part in the new context where the names of the published elements are the same.
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To control the number of stiffeners according to the length of the tube, create a rule in the Support part. Use the following code for the rule. if Tube_Length >150mm {Number_Of_Stiffeners =4} else {Number_Of_Stiffeners =2}
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Support



Student Notes:



Step 2: Create and Store the Part Template 5 min
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In this step of the exercise, you will create the Part Template and store it in a catalog.
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Knowledge-Based Engineering



Do It Yourself



Student Notes:



Part used: Support_Part_Template_Step2_START.CATProduct Create the Part Template Activate the “Support” part and use Insert/Knowledge Template/ Document Template Creation command You should get one document in the Documents tab In the Inputs tab you should get two geometric inputs: Support\External References\Surface.1 Support\External References\Curve.1 Publish the “Tube_Length” parameter Choose a dedicated icon and make a grab screen Store the Template in a catalog
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Create a new CatalogDocument and store the Document Template Publish the catalog object and give it the “Support” alias name (save the catalog with another name and make sure the last level is active before publishing)
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Support



Student Notes:



Step 3: Instantiate the Part Template 5 min
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In this step of the exercise, you will instantiate the Part Template in a different context.
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Do It Yourself (1/2)



Student Notes:



Part used: CATPKT_1200_destination.CATProduct



Instantiate the template Use the catalog browser to instantiate
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Select the “Use identical name” command and validate
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Knowledge-Based Engineering



Do It Yourself (2/2)



Student Notes:



Modify the assembly Open the attached ‘CATPKT_2210.CATPart’ and save it Replace the component “CATPKT_1210” by



CATPKT_2210.CATPart”
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Change the value of “Tube_Length” parameter to 200mm and notice how the Part Template instance is modified accordingly
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Tow Hook



Student Notes:



Assembly Template Recap Exercise 1 hour
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In this exercise you will create an assembly template, store it in a catalog, and reuse it in an assembly.
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Knowledge-Based Engineering Student Notes:



Design Process: Tow Hook 1 Design the assembly



Create and store the assembly template
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2
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3



Instantiate the assembly template
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Tow Hook



Student Notes:



Step 1: Design the Assembly 45 min
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In this step of the exercise you will design the hook assembly.
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Knowledge-Based Engineering



Design the Assembly (1/6)



Student Notes:



Open: CATPKT_0000_start.CATProduct Insert a new product and rename it to “TowHook” Design the Support
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In this product, instantiate the “Support” Part Template created in the previous exercise. You can also instantiate it from the “PartTemplate.catalog” As inputs, use the published elements of “CATPKT_0210.CATPart” that you will find in “CATPKT_0200.CATProduct”.



Copyright DASSAULT SYSTEMES



146



Knowledge-Based Engineering
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Design the Assembly (2/6)



Student Notes:



Activate the “Support” part and insert in it a new Geometrical Set named “Axis”. Add an Extract operation from the lateral face of the orange cylinder (CATPKT_300). A surface is added in the tree in the External References node. Create a Boundary from Extract.1. Answer Yes in the Multi-Result Management panel, and select Point.1 in the “Support” Geometrical Set (keep only one sub-element using a Near). Lateral Face Create a Fill surface from Near.1 Create a Point at the centre of Near.1 Create an infinite line (Point-Direction mode) using Point.2 and Fill.1. Create an Intersect element between Y axis of Axis System.1 and Extract.1. Keep only one subelement using a Near (select Point.1 in the “Support” Geometrical Set). Edit “Axis System.1”. Clear selection for X Axis and select Line.1 for Z axis. Hide “Axis” and “Support” Geometrical Sets.
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Design the Assembly (3/6)



Student Notes:



Add a formula to the “Tube_Length” parameter: Tube_Length=distance(Support\Point.1 ,Axis\Near.2) - Plate_Thickness –142.5mm
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Create a new Length Parameter called “Axis_Radius” and defined by formula: Axis_Radius=length(Axis\Near.1 )/(2*PI)
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Design the Assembly (4/6)



Student Notes:



Insert and modify a Liner
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In the TowHook assembly, import “Liner.CATPart”. Add a coincidence constraint between the Liner axis and the Support axis. Add an Offset constraint between the Liner planar face and the support (build a 0mm Offset plane from the support face) face as shown on the two pictures: Orientation: Opposite Offset=Support\Plate_Thickness +15mm In the Liner part, add a formula on the Pad.2 Length: Length=`External Parameters\Plate_Thickness` +`External Parameters\Tube_Length`+16mm Add a formula on the Pocket.2 Depth: Length=`External Parameters\Tube_Length`+15mm Add a formula on the Sketch.2 circle radius: Radius.4=`External Parameters\Center_Radius`-1mm Add a formula on the Sketch.1circle radius: Radius.3=PartBody\Sketch.2\Radius.4\Radius +10mm
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Design the Assembly (5/6)
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Insert and modify an Axis In the “TowHook” sub-assembly, import “Axis.CATPart”. Add a coincidence constraint between the axis of the “Axis” part and the axis of the “Liner” part. Add a coincidence constraint between the ring axis of the “Axis” part and the Line.1 in the “Support” part (see pictures). Add a 180deg angle constraint between the axis of the “Axis” part and the axis of the “Liner” part. In the “Axis” part, Edit “Shaft.1”, sketch and add a formula on “Offset.20”: Offset.20=`External Parameters\Axis_Radius` +PartBody\Sketch.2\Radius.13\Radius +2.5mm Note: “Radius.13” is the radius of the circle Edit Plane.1 offset and add the formula: Offset=PartBody\Sketch.2\Offset.20\Offset Edit Pad.2 Length and add the formula: Length=`External Parameters\Tube_Length` +`External Parameters\Plate_Thickness`+1mm
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Line.1
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Design the Assembly (6/6)



Student Notes:



Insert a Bolt
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In the “TowHook” sub-assembly, import the ‘Nut’ which is“M39.CATPart”. Add a coincidence constraint between the “Bolt”part axis and the “Axis” part axis. Add a contact constraint between the Bolt face and the Liner face. Hide the assembly constraints in the “TowHook” sub-assembly.



Copyright DASSAULT SYSTEMES



151



Knowledge-Based Engineering



Tow Hook



Student Notes:



Step 2: Create and Store the Assembly Template 5 min
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In this step of the exercise, you will create the assembly template and store it in a catalog.
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Knowledge-Based Engineering



Create and Store the Assembly Template



Student Notes:



Create the Assembly Template: Activate the “TowHook” sub-assembly and use the Insert/Document Template Creation command. You should get five documents in the Documents tab. In the Inputs tab, you should get three geometric inputs. Rename them as given below: Surface.2 = “Planar_Face” Curve.2 = “Center_CircularEdge” Surface.3 = “Axis_CylindricalFace”
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Publish the “Tube_Thickness” parameter. Choose a dedicated icon and make a screen grab.



Store the Template in a catalog: Create a new CatalogDocument and store the Document Template. Publish the catalog object and give it the “Tow Hook” alias name.
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Tow Hook



Student Notes:



Step 3: Instantiate the Assembly Template 5 min



Copyright DASSAULT SYSTEMES



In this step of the exercise, you will instantiate the assembly template in a different context.
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Knowledge-Based Engineering Student Notes:



Instantiate the Assembly Template (1/2) Open: CATPKT_Host.CATProduct



Instantiate the Assembly template from AssemblyTemplate.catalog



Instantiate the template: Select the planar face of “Plate” part Select the circular edge of “Plate”Part Select the extract face of “Input_Cylinder” face Axis_CylindricalFace
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Planar_Face
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Center_CircularEdge
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Instantiate the Assembly Template (2/2)



Student Notes:



Modify the input geometry:
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Change the value of “Axis_Radius” and “Distance” parameters and notice how the assembly template instance is modified accordingly.
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Jigs and Fixtures



Student Notes:



Master Exercise 5 hrs



In this exercise you will create an assembly template which can be reused in a new context. You will:
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Create the skeleton in order to drive the Position and Configuration of each Part of the Assembly. Design Non Standard Parts in context Create an Assembly Template Store the Template in a Catalog Instantiate the Template in a new context
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Jigs and Fixtures Step 0: Understanding the Design Intend and Recommendations



15 min
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In this step you will: Understand the design intend of the Jigs and Fixtures exercise. Learn the recommendations for designing (in context) an assembly which is to be later converted into a template.



VERTICAL Configuration.
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HORIZONTAL Configuration
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Do It Yourself (1/8) Part used: J&F-Template_End.CATProduct The design intent is to create an assembly template which can be reused in a new context.



Copyright DASSAULT SYSTEMES



Assembly Template
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Different configurations of the Assembly Template.
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Do It Yourself (2/8) The parameters and inputs of the Assembly templates are shown below. Finger Support Stirrup



l L1



= Angle (Horizontal, Rotation Axis) = 0°



H



L = Length (CLP, Rotation Axis)



L



l = Finger length = L-Length Stirrup H = Height Finger = 67mm L1 = Length Stirrup



70mm



L1 = 54mm if VERTICAL L1 = 82mm if HORIZONTAL Non- Standard Part (Finger & Blade) Blade
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INPUTS: Tooling Body Riser
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-



Clamping Points



-



Top Table Surface



-



Car reference axis system
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Do It Yourself (3/8) The following images give an idea of possible configurations of the assembly.



h



14 Riser configurations (7 Left & 7 Right) Riser Configuration



Configuration based on Rotation Axis’ Vertical Position Right / Left Configuration



155mmbetter understanding
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Do It Yourself (6/8)



Student Notes:



Constraints Most of the time (95%) constraints are created between Skeleton and Parts, not Part/Part While creating a constraint, select first the skeleton published elements and in second the published elements coming from Parts => better understanding of the Constraints Tree Try to create as much as possible Coincidence Constraints In the constraint Panel use “same” or “opposite” direction and never “undefined” Create set of constraints in order to have a better tree understanding
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Non- Standard Part Creation NSTD Parts are positioned with the skeleton through Constraints Do not use external planes for sketch support, use internal plane (as xy, yz or xz) and constrain NSTD Part with the Skeleton Try to import ( copy / Paste with links from the skeleton) Parameters instead of WSD Elements: for example if a length in the NSTD sketch corresponds to a distance between 2 planes in the Skeleton, create in the skeleton a parameter length corresponding to this distance, publish it and copy paste it with links in the NSTD Parts and use this external parameters in the NSTD Parts.
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Do It Yourself (7/8)



Student Notes:
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All the Multi Model Links must be created with Copy / Paste with Links of Publications which a key point designing the template parts.
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Do It Yourself (8/8)



Student Notes:
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To create the geometrical constraints between the Skeleton and Parts you must publish the necessary elements in both Parts. If you want to use Parameters from the skeleton in one of the Template’s Parts you must publish the Parameter in the Skeleton (see the Publication course).
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Jigs and Fixtures



Student Notes:



Step 1: Understanding the Skeleton Part 10 min
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In this step you will: Understand the wireframe geometry created in the Skeleton part.
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Do It Yourself (1/1)



Student Notes:



Part used: JF_Template_Start_Step1.CATProduct Observe the wireframe geometry created in the geometrical sets ‘ReferenceElements’, ‘Driving-Elements’, ‘Driving-Elements-For-Rotation-Axis’.
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Note that these wireframe elements are directly or indirectly linked to the ‘Top-Table-Surface’ plane or the ‘Clamping-Point’.



You can open the wireframe geometries and see its definition.
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Jigs and Fixtures



Student Notes:



Step 2: Creating Parameters to Drive the R/L Configuration 20 min



Copyright DASSAULT SYSTEMES



In this step you will: Create geometries and parameters which will manage the Left / Right configuration of the Assembly Template. Create parameters and formulae.
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Right / Left Configuration
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Do It Yourself (1/2)



Student Notes:



Part used: JF_Template_Start_Step2.CATProduct In the attached part, note the two planes which are created by offsetting the Symmetry-Ref-Plane on either side.



In the Skeleton part, Create a new parameter of the type ‘Angle’. Rename it as ‘Angle-Measure’ and assign the following formula to it.
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Create a new parameter of type Length. Name it as ‘Rotation-Axis-Vertical-Position’ and assign it a value of 50mm. Also create a formula to equate the Length parameter of ‘Driving-Point-Axis’ to the ‘Rotation-Axis-Vertical-Position’ parameter as shown below.



=
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Do It Yourself (2/2)



Student Notes:



Create a new parameter of type String named Side-Position-R/L with multiple values = Right and Left. Keep Right as the current value of this parameter.



In the geometrical set – ‘Driving-Elements-Switch-Right/Left’, create a new parameter of type ‘Plane’. Name it as ‘Side-Plane’ Create a rule (as shown below) to assign the good value to the parameter ‘SidePlane’ depending on the value of the ‘Side-Position-R/L’ parameter.
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if `Side-Position-R/L`=="Right" `Driving-Elements-Switch-Right/Left\Side-Plane`=`Driving-Elements-Switch-Right/Left\Offset-Symmetry-Plane-Right` if `Side-Position-R/L`=="Left" `Driving-Elements-Switch-Right/Left\Side-Plane`=`Driving-Elements-Switch-Right/Left\Offset-Symmetry-Plane-Left`
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Jigs and Fixtures



Student Notes:



Step 3: Parameterization the Top-Finger & Finger-Support Part.



30 min



In this step you will: Create parameters and constraints for the Top-Finger and Finger-Support part which are inserted in the Assembly.
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Finger-Support
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Do It Yourself (1/5) Part used: JF_Template_Start_Step3.CATProduct In the attached product, note that the two parts – ‘Top-Finger’ and ‘Finger-Support’ have been inserted. Finger-Support Top-Finger



= In the Top-Finger part, create a length parameter named ‘Length’ = 106mm and ‘Height’ = 82mm.
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In the Top-Finger, open the sketch and equate the dimensions of the sketch to the ‘Length’ and ‘Height’ parameters as shown in the adjoining image.



Copyright DASSAULT SYSTEMES



=



173



Knowledge-Based Engineering



Do It Yourself (2/5)



Student Notes:



In the Top-Finger, in the geometrical set.1, note the geometries created. Also note that publications of these geometries have been created to link them to other parts.
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Similarly, in the Skeleton part, note the published elements namely CLP, Symmetry-Ref-Plane and Horizontal-Plane. These elements are published for the purpose of linking them to other parts. In the ‘Skeleton’ part, Create a length parameter named ‘Rotation-Axis-Horizontal-Position’ = 150mm Create a length parameter named ‘Length-Stirrup’ = 54mm Create a length parameter named ‘Length-Finger’ = `Rotation-Axis-Horizontal-Position`- `LengthStirrup` Create a length parameter named ‘Height-Finger’ = 57mm + `Rotation-Axis-Vertical-Position`
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Do It Yourself (3/5) In the ‘Skeleton’ part, Publish the following parameters: Length-Finger and Height-Finger From the menu Select Tools > Publications Click the ‘Parameters…’ button of the Publication dialog box. Select the parameter from the specification tree and click OK.



Copy the Length-Finger and Height-Finger parameter from the Skeleton part (using its publication) and paste them in the Top-Finger part. (use the keep links option) as shown below.
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1



Copy
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Do It Yourself (4/5)



Student Notes:



In the ‘Top-Finger’ part, for parameters ‘Length’ and ‘Height’, create the following formulae. `External Parameters\Length-Finger`+ PartBody\Sketch.1\Length.11\Length /2 `External Parameters\Height-Finger`



Note that the external parameter is used in this formula.
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In the Skeleton part, note that in a new geometrical set (shown below), two planes have been created (using the offset option).



For the offset parameters of these planes, create the formulae as shown above.
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Do It Yourself (5/5)



Student Notes:



In the Skeleton part, note that references Horizontal-Plane-For-Support-Top-Finger, Extremity-Plane-For-Support-Top-Finger, Side-Plane are published.
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Also note the constraints created between the Skeleton part with Top-Finger and the Finger-Support.



These constraints have been created using the published referenced elements.
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Jigs and Fixtures Step 4: Parameterization of the Stirrup and Tooling Body 30 min
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In this step you will: Create parameters and rules for Stirrup and Tooling Body to manage the HORIZONTAL or VERTICAL configuration.
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VERTICAL



HORIZONTAL
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Do It Yourself (1/4)
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Part used: JF_Template_Start_Step4.CATProduct In the Skeleton part, note that the parameter Length-Stirrup, the geometric elements Offset-Plane-Axis and Axis are published.



Also note the geometric elements created in the new geometrical set ‘DrivingElements-Tooling-Body-H/V’. These elements are created to manage the Horizontal / Vertical configuration of the tooling body. Also the Stirrup and the Tooling Body parts have been inserted in the assembly.
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In the ‘Skeleton’ part, create a new parameter of the type String named ‘TOOLINGCONFIGURATION’ having multiple values = ‘HORIZONTAL’ and ‘VERTICAL’. In the Skeleton part, create a Rule named ‘Tooling-Body-H/V’ to manage the LengthStirrup parameter depending on the TOOLING-CONFIGURATION parameter. Rule:
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In the Skeleton part, in the geometrical set ‘Driving-Elements-Tooling-Body-H/V’, create a new parameter of the type Plane. Name it as ‘H/V-Plane-Tooling-BodyHorizontal-Plane’. Publish the newly created plane.



Create a Rule named ‘Toolind-Body-H/V’ to assign a good value to the ‘H/V-Plane-Tooling-BodyHorizontal-Plane’ depending upon the value of the ‘TOOLING-CONFIGURATION’ parameter.
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Rule:



Copy the ‘Length-Stirrup’ parameter from the Skeleton part (using its publication) and paste it in the ‘Stirrup’ part. (use “Paste Special >As Result With Link” option)
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Do It Yourself (3/4) In the ‘Stirrup’ part, note that there is a parameter named ‘Length’ which controls the overall length of the ‘Stirrup’. (Refer Sketch.1)



PartBody\Sketch.1\Offset.17\Offset



=



=



Length=`External Parameters\Length-Stirrup`+PartBody\Sketch.1\Offset.17\Offset /2
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For the ‘Length’ parameter in the Stirrup part, create the formula as shown above.
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Also note the constraints created between the Skeleton part with Stirrup and the Tooling-Body. You can double-click the constraints to open and view the elements which are used to constrain the parts.



These constraints have been created using the published referenced elements.
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Activate the root product and create a coincidence constraint between the Skeleton and Tooling body. Use publications to create constraint. (as shown below)
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Jigs and Fixtures Step 5: Managing Adapter Switch for H/V Configuration 30 min
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In this step you will: Manage the presence of 2 adapters for the HORIZONTAL / VERTICLE configurations.
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HORIZONTAL
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Do It Yourself (1/4) Part used: JF_Template_Start_Step5.CATProduct In the assembly note that two new parts having names ‘Adapter’ and ‘Adapter2’ in the specification are added. These parts have filenames as shown below. Bottom_finger_support_2.CATPart Bottom_finger_support.CATPart In the Skeleton part, note that the parameters ‘Side-Position-R/L’ and ‘TOOLING-CONFIGURATION’ are published.
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In the adapter part, note that the parameter Side-Position-R/L is pasted from the Skeleton part.
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Do It Yourself (2/4)
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In the Adapter part, note that a parameter named ‘Support_config’ is created and is governed by the rule ‘Manage-R/L’. Another rule ‘Manage_config’ manages the Symmetry plane. The representation of flow is shown below.



=



In this way, the geometry for the ‘Adapter’ part is managed as per the ‘Side-PositionR/L’ parameter in the Skeleton.
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In the root product, create a Rule to Activate or Deactivate ‘Adapter’ or ‘Adapter2’ depending on the ‘TOOLING-CONFIGURATION’ parameter. Use the script given below. if `..!Skeleton-J&F-Template!TOOLING-CONFIGURATION`=="HORIZONTAL" { `Adapter2.1\Component Activation State`=false `Adapter.1\Component Activation State`=true }
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if `..!Skeleton-J&F-Template!TOOLING-CONFIGURATION`=="VERTICAL" { `Adapter2.1\Component Activation State`=true `Adapter.1\Component Activation State`=false }
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Do It Yourself (4/4)
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Also note the constraints created between the Tooling-Body with Adapter1 and Adapter2.
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Jigs and Fixtures Step 6: Managing Riser Positions 30 min
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In this step you will: Automatically manage the positions of the risers depending on the value of the Vertical / Horizontal parameter.



Copyright DASSAULT SYSTEMES



10mm



Distance (Riser & Rotation Axis) =10mm in HORIZONTAL Configuration
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Do It Yourself (1/5) Part used: JF_Template_Start_Step6.CATProduct In the attached part, note the new parts namely ‘Left_double_riser_CLP’ and ‘Right_double_riser_CLP’ have been inserted. In the Skeleton part, create the following parameters of the Length type and values as shown below. Name: Riser-Position-VERTICAL-Configuration Helping-Riser-Configuration Riser-A length Riser-H length Riser-Theorical-length



Value: 75 mm 100 mm 200 mm 200 mm 300 mm



Create a parameter named ‘Riser-Config’ of the type integer. In the Skeleton part, create a new design table and link it to ‘Design_Table.1.xls’. The .xls file is located in the same folder where the attached assembly is stored.
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Using the menu ‘File > Save As’, you can find the location of the attached assembly.



Associate the 2 Parameters previously created (Riser-A length & Riser-H length) with the 2 columns of the DT.
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Student Notes:



In Skeleton part, note that a new geometrical set named ‘Driving-Elements-ForRiser-R/L’ is created. Equate the ‘Length’ parameter of the point ‘Ref-Point-ForRiser-V’, to the parameter – ‘Riser-Position-VERTICALConfiguration’. Similarly equate the length parameter of the point ‘Ref-Point-ForRiser-Height’, to the parameter – ‘Helping-Riser-Configuration’. In the geometrical set ‘Driving-Elements-For-Riser-R/L’, create a new parameter of the type ‘Plane’ (Name = Riser-Symmetric-Drivng-Plane-H/V). Create a rule named ‘Riser-Driving-Plane’ to assign the good value to the plane parameter depending on the ‘TOOLING-CONFIGURATION’ parameter.
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if `TOOLING-CONFIGURATION`=="HORIZONTAL" `Riser-Symmetric-Driving-Plane-H/V`=`Driving-Elements-For-Riser-R/L\Driving-Plane-For-Riser-H` if `TOOLING-CONFIGURATION`=="VERTICAL" `Riser-Symmetric-Driving-Plane-H/V`=`Driving-Elements-For-Riser-R/L\Driving-Plane-For-Riser-V`
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Do It Yourself (3/5)



Student Notes:



For the parameter ‘Riser-Theorical-length’, create the formula using the ‘distance’ function as shown below. distance(`Reference-Elements\Offset-Omm-Top-Table-Surface`,`Driving-Elements-For-Riser-R/L\Ref-Point-ForRiser-Height`)



Set Riser-Config to the closest inferior available "A length" of the Design Table (Compared to Riser Theorical Length). Create the formula as shown below. Relations\DesignTable.1\Sheet .CloserInfConfig("`A lenght`",`Riser-Theorical-length`)



Equate the ‘Configuration’ value of the design table, to the ‘Riser-Config’ parameter. =



Publish the following entities:
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Riser-Config parameter Offset-Omm-Top-Table-Surface Riser-Symmetric-Driving-Plane-H/V
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Do It Yourself (4/5)



Student Notes:



Create the 3 constraints between the Skeleton and the Left-Riser Coincidence: Offset-0mm-Top-Table-Surface & Bottom-plane Coincidence: Riser-Symmetric-Driving-Plane-H/V & Transversal-Plane Coincidence: Symmetry-Ref-Plane & Symmetry-Plane Note: As mentioned in the recommendations, you will have to create these constraints using Publications.



Create the 3 constraints between the Skeleton and the Right-Riser Coincidence: Offset-0mm-Top-Table-Surface & Bottom-plane Coincidence: Riser-Symmetric-Driving-Plane-H/V & Transversal-Plane Coincidence: Symmetry-Ref-Plane & Symmetry-Plane
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In both the Riser parts, copy and paste the ‘Riser-Config’ parameter (with link)
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Do It Yourself (5/5) In each Riser, create a Rule to assign the Good Config to the Riser. Use the script given below. if `External Parameters\Riser-Config` Riser_config ="GAGBD901" if `External Parameters\Riser-Config` Riser_config ="GAGBD902" if `External Parameters\Riser-Config` Riser_config ="GAGBD903" if `External Parameters\Riser-Config` Riser_config ="GAGBD904" if `External Parameters\Riser-Config` Riser_config ="GAGBD905" if `External Parameters\Riser-Config` Riser_config ="GAGBD906" if `External Parameters\Riser-Config` Riser_config ="GAGBD907"



==1 ==2 ==3 ==4 ==5 ==6 ==7
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In the root product, create a Rule to activate or deactivate the Left or Right Riser depending on the ‘Side-Position-R/L’ parameter. Use the script given below. if `..!Skeleton-J&F-Template!Side-Position-R/L`=="Right" { `Right_Double_Riser_CLP.1\Component Activation State`=true `Left_Double_Riser_CLP.1\Component Activation State`=false } if `..!Skeleton-J&F-Template!Side-Position-R/L`=="Left" { `Left_Double_Riser_CLP.1\Component Activation State`=true `Right_Double_Riser_CLP.1\Component Activation State`=false }
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Step 7: Designing (in context) the Blade 30 min
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In this step you will: Design the blade in context of the template assembly and create a Rule to adjust the design of blade depending on the ‘TOOLING-CONFIGURATION’ parameter.
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Do It Yourself (1/4) Part used: JF_Template_Start_Step7.CATProduct In the attached assembly, note that a new part named ‘Vertical-Blade’ has been inserted. Note the constraints between the Skeleton and the Blade. These constraints have already been created for you.



In the skeleton part, note the geometric elements which are created in the new geometrical set – ‘Driving-Elements-For-Blade’. The same elements are also published.
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In the Blade part, the following elements have been imported: 1) From the Skeleton: Riser-H-Length TOOLING-CONFIGURATION Extremity-Plane-For-Blade Lower-Plane-For-Blade Extremity-plane-For-Blade-2 Offset-0mm-Clamping-Point Offset-0mm-Top-Table-Surface
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2) From the Adapter 1: Axis 1 Axis 2 Top-plane 3) From the Adapter 2: Axis 1 Axis 2 Plane-Top-Blade



You can see the list of External References and External Parameters of the Blade part to know the imported elements.
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Do It Yourself (2/4) In the Blade part, Sketch.1 and Sketch.2 are created and also other datum elements are created. Here, a rule is to be created which will assign values from the external references. This rule will take into consideration the TOOLING-CONFIGURATION. The image shown below represents the flow.



Adapter part



Axes



2 1



Based on the ‘Good’ Adapter part, appropriate Axes are assigned to the parameter elements created in the geometrical set.



2



Either Sketch.1 or Sketch.2 is assigned to BladeSketch-H/V which is used to create the Pad.1 for the Blade.
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Use the following script to create a Rule in the Blade part.



let Line1(Curve) let Line2(Curve) let Line3(Curve) let Line4(Curve) let Line5(Curve) let Line6(Curve) set Line1=`External References\Curve.1` set Line2=`External References\Curve.2` set Line3=`External References\Curve.3` set Line4=`External References\Curve.4` set Line5=`External References\Curve.8` set Line6=`External References\Curve.6`
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if `External Parameters\TOOLING-CONFIGURATION`=="HORIZONTAL" { `Holes-Positionning & Sketch-Choice\Blade-Sketch-H/V`=`Holes-Positionning & Sketch-Choice\Sketch.1` `Holes-Positionning & Sketch-Choice\Axis-Hole1-H/V`=Line3 `Holes-Positionning & Sketch-Choice\Axis-Hole2-H/V`=Line4 `Axis-Hole3-H/V`=Line6 } if `External Parameters\TOOLING-CONFIGURATION`=="VERTICAL" { `Holes-Positionning & Sketch-Choice\Blade-Sketch-H/V`=`Holes-Positionning & Sketch-Choice\Sketch.2` `Holes-Positionning & Sketch-Choice\Axis-Hole1-H/V`=Line1 `Holes-Positionning & Sketch-Choice\Axis-Hole2-H/V`=Line2 `Axis-Hole3-H/V`=Line5 }
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Do It Yourself (4/4) In the Blade part, for Sketch.1 and Sketch.2, for the dimensions, create the formulae as shown below. 3



4



1



2



5



1 distance(`External References\Offset-0mm-Clamping-Point`,`External References\Offset-Omm-Top-Table-Surface`) - `External Parameters\Riser-H length` Copyright DASSAULT SYSTEMES



2 distance(`External References\Offset-0mm-Clamping-Point`,`External References\Result of Extremity-Plane-For-Blade`) 3 Length + `Holes-Positionning & Sketch-Choice\Sketch.2\Length.21\Length`/2 4 distance(`External References\Offset-0mm-Clamping-Point`,`External References\Offset-Omm-Top-Table-Surface`) - `External Parameters\Riser-H length` 5 distance(`External References\Offset-0mm-Clamping-Point`,`External References\Result of ExtremityPlane-For-Blade`) + `Holes-Positionning & Sketch-Choice\Sketch.2\Length.21\Length`/2
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Step 8: Creating Checks and Reactions 30 min



Copyright DASSAULT SYSTEMES



In this step you will: Create checks to display information / warning to inform the user about the company standards. You will also customize the specification tree of the skeleton for better understanding.
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Part used: J&F-Template_Start_Step8.CATProduct



Copyright DASSAULT SYSTEMES



In the Skeleton part, create Parameter-Sets and group the parameters as shown below.
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Create range for the parameters as shown below.



155mm < Rotation-Axis-Horizontal-Position < 200mm
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100mm 15 Deg. The system will automatically switch this Vertical Position to the nominal position: Angle= 0 deg") `Rotation-Axis-Vertical-Position`= 0mm }
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Create a check in order to verify the ‘Angle-Measure’ parameter.
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Step 9: Creating the Template 30 min
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In this step you will: Create and store the assembly template Use it in a new context.
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Do It Yourself (1/5)



Student Notes:



Part used: JF_Template_Start_Step9.CATProduct Activate the root product and open the ‘Document Template Creation’ dialog box and create the Document Template. From the menu select Insert > Document Template Creation Activate the ‘Inputs’ tab and select the following as the inputs: Car-Axis-System Clamping-Point Top-Table-Surface
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Activate the ‘Published Parameters’ tab, click the ‘Edit List’ button and select the following inputs: Side-Position-R/L TOOLING-CONFIGURATION Rotation-Axis-Vertical-Position Rotation-Axis-Horizontal-Position Helping-Riser-Configuration In the ‘Published Parameters’ tab, activate the option ‘Auto modify part numbers with suffix’ and add ‘__’ as the suffix.
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Activate the ‘Documents’ tab. In the External Documents field, add the downstream documents which you want to duplicate during the instantiation of the template. Downstream documents could be NC Process, Drawing, CATAnalysis etc. For this case, select the 2D Drawing associated with the Non-Standard Parts. This drawing has been already created and are located in the folder of the root product. You can create and add more drawings if required.
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Activate the ‘Properties’ tab, select an icon of your choice and click OK to the ‘Document Template Creation’ dialog box.
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Do It Yourself (3/5) Create a new catalog and store the Document Template in it. From the menu select File > New – Select ‘CatalogDocument’ Add a family. Activate the family and add a component.



‘Add Family’ button



In the ‘Description Definition’ dialog box, click ‘Select external feature’. From the specification tree, select the ‘Document Template’ icon and click OK.
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Save and close the catalog.



Copyright DASSAULT SYSTEMES



207



Knowledge-Based Engineering
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Part used: CELL.CATProduct



Open Cell.CATProduct and instantiate the Document Template from the catalog which you created in the previous step. In Cell.CATProduct, note that the Tooling product has a Skeleton part which contains the required inputs for the instantiation of the Document Template. Axis System



Clamping Points
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Top Table Surface



Activate the ‘Tooling’ product, click the Catalog Browser and select the catalog which was created in the previous step.
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Activate the ‘Tooling’ product, click the Catalog Browser and select the catalog which was created in the previous step. For the three inputs, select the published elements from the parts as shown below.



2



3
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Change the orientation of the Jig by clicking the orientation line if required. Similarly, you can instantiate the template on the other clamping points.
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Step 10: Protecting the IP 30 min
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In this step you will: Lock your design and protect the intellectual part of your design so as to distribute it to the end users.
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Part used: Skeleton_JF_Template_UDF_Creation_Start.CATPart In the attached part, create a string parameter named COMPANY-NAME = COMPANY-XXXX. Lock this parameter.



Create a user feature as described in the following instructions: From the menu select Insert > Knowledge Templates > User Feature.
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For the ‘Definition’ tab, select the following elements from the specification tree:



Select all the formulae in the tree by clicking them. Select all the Rules, Reactions and checks by clicking them in the tree. Select all set of ‘Helping Parameters’ by clicking it in the tree. Also select the COMPANY-NAME parameter and the Angle-Measure parameter.
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In the Parameters tab, publish the following parameters. - Riser-A-Length - Riser-H-Length - Riser-Config - Length-Stirrup - Company-Name - Angle-Measure - Length-Finger - Height-Finger - Riser-Theorical-length
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In the Outputs tab, make sure that you have all the necessary elements. (A list is given in the next slide). If any element is missing, click the add button and select it from the specification tree through PUBLICATION and add it in the lit of Outputs.
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Following are elements which must be present in the list of ‘Outputs’ tab. If any element is missing, click the add button and select it from the specification tree through PUBLICATION and add it in the list of Outputs.
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Extremity-Plane-For-Support-Top-Finger Offset-0mm-Inverse-Offset-Plane-Axis H/V-Plane-Tooling-Body-Horizontal-Plane Extremity-Plane-For-Blade Lower-Plane-For-Blade Extremity-plane-For-Blade-2 Offset-0mm-Clamping-Point (Use CLP Here) Horizontal-Plane Symmetry-Ref-Plane Horizontal-Plane-For-Support-Top-Finger Side-Plane Offset-Plane-Axis Axis Riser-Symmetric-Driving-Plane-H/V Offset-Omm-Top-Table-Surface Extremity-Plane-For-Blade Lower-Plane-For-Blade



Click OK to the Userfeature Definition dialog box. Save the part.
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Do It Yourself (4/6) Part used: Skeleton_JF_Template_UDF_Instantiation_Start.CATPart Open the Skeleton_JF_Template_UDF_Instantiation_Start.CATPart and instantiate the User Defined Feature which you have recently created. In the attached Skeleton part, note that the geometrical sets which were present have been deleted due to which the publications have failed. 1 Instantiate the UDF
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3



3



Copy & Paste (with link) the geometric elements in a new geometrical set.



Link these elements to broken publications.



The idea here is to instantiate the UDF in this part, copy the instantiated elements in a new geometrical set and link them to the broken publication. Instructions are given in the next slide.
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Do It Yourself (5/6) From the menu select Insert > Instantiate From Document and select the part in which you had created the UDF. (You can also use the attached ‘Skeleton_JF_Template_UDF_Creation_End.CATPart’ Select the inputs: You can click the ‘Use identical Names’ button to select all the required inputs. Create a new geometrical set. Name it as “Link-To-UDF-Inputs” and copy the geometrical elements from the UDF to the new geometrical set.
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Reconnect all the broken publications as shown above. Also reconnected the broken publication of the parameters. You can directly select the respective parameters from the instantiated User Defined Feature.



Reconnecting publications is necessary to automatically reconnect the Assembly Constraints in the template which were created using the publications.
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Part used: J&F-Template_Skeleton_Replacement.CATProduct Save the part by the name ‘Skeleton_JF_Template_Locked.CATPart’ to some location. Open ‘J&F-Template_Skeleton_Replacement.CATProduct’. Activate the root product and replace the Skeleton part – “Skeleton-J&F-Template” by the one you have saved recently. (Skeleton_JF_Template_Locked.CATPart) You can also use the attached part (Skeleton_JF_Template_UDF_Instantiation_End.CATPart) for replacement. After replacement, update the root level assembly and note that the constraints have been replaced.
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Thus the Assembly Template is now IP protected. No on can edit the Rules, Reactions and formulae. The knowledgeware elements are hidden. Only the inputs elements and parameters are available.



END OF EXERCISE.
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